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Logging into DC Redistricting Online 

https://dcredistricting.esriemcs.com/
https://dcredistricting.esriemcs.com/
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Opening a Redistricting Plan 

 
 

 

Immediately after logging into the application, the Open Plan window is shown. Here you can open the 
starting template plan, a plan you’ve saved previously, or a plan that someone has shared with you.

To open the starting template, select the “Shared Plans” folder, then the “Everyone” group within it, 
and then the Starting Template item from the list in the center of the window.  Then click the “Open 
Plan” button at the bottom right of the window.

To open a plan you saved previously, select the “My Plans” folder and then the desired plan name 
from the list in the center of the window, then click the Open Plan button. 

To open a plan that has been shared with you, select the “Shared Plans” folder, then the name of 
the group that contains the desired shared plan, and then the desired plan name from the list in the
center of the window. Click the Open Plan button. 

To open a plan you saved locally, click on the “Open Local Plan” button in the bottom left corner of 
the window and navigate to the plan’s saved location.
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Main Application Window 

After opening a plan you can access the full redistricting application, which is composed of three main
parts: The Tool Ribbon at the top, the Map in the center, and the District Window at the bottom.

Tool
Ribbon

Map

District
Window

The Tool Ribbon organizes the application’s functions into tabbed groups. Click a tab name to access 
the tools contained within it.  Each tab and its tools are described in the following sections of this guide.

The Map displays the current Ward boundaries of the redistricting plan as well as the Census 
geographies contained within them and a basemap showing streets, waterways, landmarks etc.
The map extent can be changed by double clicking within it, by using the Plus/Minus buttons in the top 
left corner, or by using the Map Navigation tools found in the Create tab.

The Sidebar window, located at the leftmost edge of the Map, can be expanded 
by clicking the small arrow at the top.
When expanded, the Sidebar has three tabbed views that can be toggled from 
the bottom of the window– Contents, Legend, and Identify.
The Contents view displays additional reference layers that can be added to 
the map.
The Legend view displays the line style of the Census geographies shown on 
the map.
The Identify view displays Census population statistics for selected Census 
geographies.  It is controlled by the Identify tool on the Create tab.
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The District Window displays map options and Census population statistics for the Wards as defined 
by the current plan.

The District column includes a row for each Ward, as well as the 
“Unassigned” row which displays summary statistics for any Census 
geographies that have not yet been assigned to a Ward.
The Color column defines the colors used to display each Ward.  You can 
change these colors by clicking on a color box and selecting a different color.
The check boxes in the Hide and Lock columns determine whether a selected 
Ward is hidden or locked (protected from edits) on the map.

The numerical columns display Census population statistics for the Wards 
based on their current boundaries.  These values are updated continuously 
as you make changes to the boundaries on the map.  The set of statistics 
displayed is controlled with the Demographics button on the Create tab.
The Total column is the total population for each Ward based on the current 
boundaries.
The Target_Dev column shows how far above or below the total population is 
from the numerical ideal value of 86,193.
Following these columns are the Census demographic statistics that have 
been specified using the Demographics button on the Create tab.



6

File Tab 

The File tab contains tools for managing redistricting plan files.  Its components are:

New will create a new blank plan from scratch.  All the parameters of the new plan must be specified 
manually.  This is not recommended; instead, to create a new plan, open the “Starting Template” plan 
and modify it as desired.

Open will display the same “Open Plan” dialog that is shown when you first log in, allowing you to open 
a different plan.

Save will save changes to the current plan under the same name from which it was opened.

Save As will save changes to the current plan under a new name.  The “Save Plan” window is 
displayed to specify a new name and description for the plan

Open Local will display a file browser window where you can specify the location of a locally-saved 
plan to open.

Save Local will display a prompt for a file name for the plan.  Specify a name and click OK, then “Save 
File” and select a location for the plan file.

Export allows you to save the plan boundaries to common GIS file formats including KML and 
Shapefile.  Select the desired file format, enter a name for the exported file and then a save location.

Print creates a PDF map of the current plan, with 
controls to customize the map content and layout.  A 
north arrow, scale bar, legend and custom text can 
be added, customized, and relocated on the page.  
When you’ve finished customizing the map, click the 
“Print” button at the bottom left corner of the window 
to save the PDF and return to the application.  Click 
the “Cancel” button at the bottom right corner to 
return to the application without saving a PDF.

Plan Book is similar to “Print” but creates a multi-
page PDF of the current plan: one page for the entire 
plan and an additional page for each individual Ward.  
Use the “Previous Page” and “Next Page” buttons in
the middle of the window to customize each page of 
the plan book individually. Click the “Print” button to 
save the PDF, or “Cancel” to return to the application 
without saving a PDF.
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View Tab 

The View tab contains tools for customizing the appearance of the redistricting application.  Changes 
made here are saved to each plan individually.  Its components are:

Number of Districts specifies the number of Wards the application calculates.  It is locked at 8.

Target Mean is the numerically ideal population for each Ward.  It is determined by dividing the 2020 
US Census population of the District (689,545) by the number of Wards (8). 689,545 ÷ 8 = 86,193

Show Target Values, when checked, adds a column to the District Window showing the Target Mean
value (86,193) for each Ward.

Display Lines shows the plan’s Ward boundaries outlined in the colors selected in the District Window.

Fill Districts shows the plan’s Wards boundaries in black, and the Ward interiors with the colors 
selected in the District Window. “Display Lines” and “Fill Districts” are mutually exclusive – they can not 
both be selected at once.

Display Locks shows any currently locked Wards with a diagonal hatchline pattern across their 
interiors.

Display Names displays a name label for each Ward – “Ward 1”, “Ward 2”, etc.

Shorten Names displays a number label for each Ward – “1”, “2”, etc.

Show District Field adds the current population to each Ward’s label.

Deviation Coloring allows you to customize the warning colors for Wards that are above or below the 
allowed population range.  The default values show labels in green for Wards that are above the 
allowed population, and in red for Wards that are below the allowed population.

District Window moves the District Window table from below the map into its own window, allowing 
more space for the map to be displayed.  To return the District Window to its previous location, close 
the popout window and it will snap back in place.
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Create Tab 

The Create tab contains the tools for selecting which Census population statistics to work with, for 
assigning Census geographies to Wards, and for navigating the map.  Its components are:

The Demographics button opens a window
to select which Census population statistics 
are displayed in the District Window of the 
application.
The available statistics are organized into 
groups; expand a group to select statistics
from within it or select the group name to 
include all statistics within it.  You can show 
each statistic as the actual count and/or as
the percentage of the total population (“Sum” 
and “Percent”) in the District Window by 
checking the appropriate box.
The right side of the window shows a 
description of each statistic.

The Redistricting section contains tools for assigning Census geographies to Wards.

The “District:” dropdown tool specifies which Ward the selection tools 
below it will apply to. Click the down arrow to select a Ward. The tool is synchronized with the Ward 
selection shown in the District Window – making a selection in one will automatically be reflected in the
other.

The Select Geographies tools are used to assign Census geographies to the selected
Ward.  The tools select geographies by (from left to right) clicking a point on the map, dragging a 
rectangle across the map, drawing a polygon on the map, and drawing a line on the map.  Any Census 
geographies that are beneath the point, rectangle, polygon or line drawn are added to the selected 
Ward.

The Undo and Redo buttons reverse and reapply changes made with the Select Geographies 
tools. 

The Zoom to Selected tool will change the current map extent to the boundary of the currently
selected Ward.

The Lock and Unlock buttons control whether the currently selected Ward is editable. When
locked, the Census geographies included within a Ward cannot be changed by the selection tools.  A 
Ward’s lock status is visible both in the “Lock” field of the District Window, and by a crosshatch line 
pattern on the map (if that option is enabled in the View tab). 

The Find Unassigned button zooms the map to any Census Geographies that haven’t been 
assigned to a Ward. 
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The Map Navigation Tools section contains tools for panning and zooming the visible map extent, and 
for querying the Census statistics associated with selected Census geographies.

The “Display Level:” header specifies what level of Census geography is 
currently displayed on the map.  The three levels are Tract, Block Group, and Block.

The Map Navigation tools allow you (from left to right) to pan the map, zoom in on
the map by clicking or dragging a rectangle, zoom out on the map by clicking or dragging a rectangle, 
zoom to the previous map extent, zoom to the next map extent, and zoom out to the full extent of the 
redistricting plan.

The Identify tool displays Census population statistics for 
the selected Census geography.  Select the tool, then click on a 
Census Geography on the map.  The Identify window will 
expand from the left side of the application and display all 
Census statistics for that geography.
Check the “Use Grid Demographics Only” box to instead display 
only the Census statistics that are present in the District Window.
When finished using the Identify tool, click the “Clear” button to 
clear the yellow selection from the map.
You can close the Identify window by clicking the small arrow at 
the top left corner of the window.

The Scalebar section displays information about the map’s current zoom level and scale.

The “Selection Level” header specifies what level of Census geography will
be selected when using the Select Geography tools.  It will be the same as the “Display Level” header 
above the map navigation tools. The three levels are Tract, Block Group, and Block.

The Scalebar shows the current map scale both using text (“Scale 1:36K”) and 
as a yellow tick mark on the bar.  As you zoom in and out on the map, the yellow tick mark will travel 
left and right along the scalebar and the text will update with the current value.
The magenta tick marks show the scales at which the displayed and selectable Census geographies 
will switch to a different level. The leftmost tick shows the scale at which the map will switch between 
Blocks and Block Groups, the middle tick where it will switch between Block Groups and Tracts, and 
the rightmost where it will switch between Tracts and none of the Census geographies (called “County” 
level).
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The Basemap button allows you change the basemap displayed beneath the plan map.  There are 
several different cartographic styles to choose from, as well as aerial photography.  Changes to the 
selected basemap are saved to each plan individually. 
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Review Tab 

The Review tab contains tools for summarizing the demographic characteristics of the redistricting plan, 
for checking the validity of the plan, and for adding graphical notes to the plan map.  Its components 
are:

Plan Histogram displays a window showing bar graphs of the population data from the District Window 
for the Wards as defined by the current plan.  Use the dropdown at the top of the window to change the 
population statistic being graphed.

Plan Distribution displays a window showing pie charts of the population data from the District 
Window for the Wards as defined by the current plan.  Use the dropdown at the top of the window to 
change the population statistic being charted.

District Distribution displays a window showing pie charts of the population ethnicity data for each 
Ward as defined by the current plan.  Use the dropdown at the top of the window to change the Ward 
being charted.

Check Integrity runs a series of validity tests on the current plan to determine whether it meets the 
required criteria for submission. The included tests are:

Dual Assignment verifies that each Census geography is 
only assigned to one Ward.

Population Summary verifies that the total population count 
in all Wards is equal to the total District population

District Count verifies that all Wards have at least one 
Census geography assigned to them.

Maximum Deviation verifies that all Ward populations are
within the allowed 5% deviation from the ideal population 
target of 86,193.

Null Assignment verifies that all Census geographies within
the District have been assigned to a Ward.

Connectivity verifies that all parts of a Ward are connected with the rest of the Ward (no “islands”).

If the plan fails any integrity tests, the “Details” button for that test will be enabled.  Clicking it will open a 
review window that shows the Ward(s) or portion of Ward(s) that are in error.  You can use this window 
to review and correct any errors and run the validity tests again.
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The Reports button displays a list of available data summary reports that the application can generate 
about the current plan.  Selecting a report will open a Report Definition window where you can specify 
which Census population variables to summarize (if applicable) as well as the report file type – PDF, 
Excel or HTML.  Click OK and the application will generate the report based on the current plan 
boundaries. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Map Notes is a collection of markup tools you can use to add notes and sketches to the plan map. 
These markups have no effect on the statistical or analytical functions of the application, they are purely 
graphical additions. 
 

 Click any of the available tools to draw lines, dots, polygons or text on the map. 
 

 You can recolor, resize, or delete an existing Map Note graphic by right clicking on it and 
selecting the appropriate option from the popup menu. 
 

 The “Clear All” button erases all map notes from the plan.  
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Share Tab 
 

 
 
The Share tab contains tools for adding supplemental information to the plan file, and for sharing the 
plan with other users.  Its components are: 
 
Attach Files opens the “Attachments” window, where you can manage any additional files you wish to 
have included with the plan. 
 
Click the “Upload File” button to add a file to the plan as an 
attachment.  A file browser window will open – navigate to 
the file location and click “Open”.  The file will upload to the 
application and the file name will appear in the attachment 
list at the center of the window. 
 
To download an attachment from the plan and save it locally, 
select the attachment from the list and click the “Download” 
button, then specify a save location. 
 
To delete an attachment from the plan, select it from the list 
and click the “Delete” button.  You will be asked to confirm; 
click Yes and the file will be deleted. 
 
Click the “Close” button to return to the main application. 
 
 
Information opens the “Plan Information” window, 
where you can briefly specify details about the plan. No 
fields are required, fill in whichever you consider 
relevant. 
More comprehensive plan information should be 
included as an attachment using the “Attach Files” 
button. 
 
 
 
 
 
 
 
Comments opens the “Comments” window, where you can add or view comments on the currently 
open plan. 
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Access Log shows the access history of the currently opened plan. 
 
Share Plan opens the “Share Plan” window, where you 
can select the groups with which the currently opened plan 
is shared.   Only groups of which you are a member are 
listed. 
 
Check or uncheck the group names to include or exclude 
them from sharing the plan.  
Under “Access level”, choose whether to allow the plan to 
be only viewable (Read Only) or editable (Read/Write) by 
members of the groups you are sharing the plan with. 
Click “OK” to save your choices, or “Cancel” to close the 
window without making any changes. 
 
 
 
 
Manage Groups opens the Manage Groups window, 
where you can: 

create groups   

edit your groups’ name/properties  

delete groups you’ve created  
 
and invite users to or remove users from groups you’ve 

created  
 
 
 
Group Invites shows your pending invitations to join a 
share group. 
Selecting an invitation from the list on the left will display 
details about the group, including its name, description, 
creator, and other members. 
Accept or decline an invitation by selecting it and 
choosing the appropriate button at the bottom left corner 
of the window. 
Note that if an invitation is declined, it is removed from 
the invitation list and can no longer be accepted. 
 
 
 
 
 
Edit Profile allows you to change the details associated with your user account, including your name, 
email address, and password.  Your username is displayed but can not be modified.
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Submit Tab 
 

 
 
Submit Plan is the only tool on the Submit tab.  Clicking it will run all of the integrity checks from the 
Review tab to determine whether the plan is valid, as only valid plans may be submitted.  If any integrity 
checks fail, you will not be able to proceed.  Correct any outstanding issues and then restart the 
submission. 
 
If all the integrity checks succeed, the “Submit Plan” contact information window will be displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter your plan and contact information in the window.  Fields with an asterisk are required. 
Click the “Submit Plan” button to submit your completed redistricting plan to Council, or the “Cancel” 
button to close the window without submitting. 
After submitting your plan, you will receive a plan submission confirmation email at the email address 
you specified in your user account. 
Once submitted, changes to a plan can no longer be saved, though they can be saved as a new plan 
using the “Save As” button on the File tab. 




